







Consignes aux auteurs



Présentation des articles





Editions Hermès



8, quai du Marché-Neuf

75004 Paris

(Adresse institutionnelle complète)

hermes@iway.fr



RÉSUMÉ. L'ensemble des consignes rassemblées ci-dessous s'organise en trois rubriques. La rédaction remercie les auteurs pour le strict respect qu'ils accorderont à ces dispositions. La taille de ce résumé ne doit pas dépasser une dizaine de lignes. Il est à composer en Times corps 9 italique, interligné 11 points. Un résumé en anglais doit l'accompagner. L'ensemble des consignes rassemblées ci-dessous s'organise en trois rubriques. La rédaction remercie les auteurs pour le strict respect qu'ils accorderont à ces dispositions. La taille de ce résumé ne doit pas dépasser une dizaine de lignes. Il est à composer en Times corps 9 italique, interligné 11 points. Un résumé en anglais doit l'accompagner.

ABSTRACT. The instructions put together below fall into three categories. The editor would be grateful to authors for respecting these indications. At times, the length of this summary may attain a dozen lines. It is to be written in size 9 italic Times. An abstract in French will be joined. The instructions put together below fall into three categories. The editor would be grateful  to authors for respecting these indications. At times, the length of this summary may attain a dozen lines. It is to be written in size 9 italic Times. An abstract in French will be joined.

MOTS-CLÉS : un maximum de mots significatifs, en français et en anglais, doivent être isolés sous forme de mots-clés.

KEY WORDS: a maximum of significant words, in French and in English, will be separated as key words.



















Signature de l’article : nom de la revue. Volume 1 – n° 1/1998, pages 1 à x

1. Introduction



Ce texte donne les consignes à respecter impérativement pour garantir la qualité et l'homogénéité des articles (qui, sauf exception, ne doivent pas dépasser 20 à 30 pages) à paraître dans les revues publiées par les Editions Hermès. Le présent texte doit être considéré comme un modèle, notamment pour la première page, l’en-tête, les inters, etc. Vous trouverez en annexe II, la liste des logiciels acceptés par le service informatique.





2. Présentation



L'ensemble des textes est composé en Times romain (Times New Roman sous PC) corps 10, minuscule, interligné 12 points exactement.

Les titres, sous-titres et autres résumés font l'objet d'un traitement particulier, expliqué ci-dessous. Par ailleurs, les auteurs qui désirent mettre en valeur un terme peuvent le faire en utilisant l'italique ou le gras, ne jamais utiliser le soulignement. Eviter au maximum d’utiliser les lettres majuscules dans les titres et dans le texte.





2.1. Format



Les pages possèdent les caractéristiques suivantes :

– largeur des textes (ou justification) : 120 mm exactement,

– hauteur des textes, y compris les notes : 190 mm maximum.

La 1re page de l'article (titre, auteur, résumé et texte) fait l’objet d’une mise en forme particulière détaillée en 2.2.1. Sur cette première page apparaîtront les éléments suivants : le titre de l’article, les nom et prénom des auteurs, leur appartenance, un résumé et des mots-clés en français et en anglais. 

L’article commencera en haut de la page 2. Tous les textes sont justifiés.



2.1.1. Marges et format



Si vous utilisez Word sous PC ou Macintosh, les marges à définir sont les suivantes, pour justification et hauteur de page de façon à obtenir un bloc texte de 120 mm x 190 mm ; dans Menu, aller à :

– Fichier > Mise en page 		H	5,35 cm	Exactement

				B	5,35 cm	Exactement

				G	4,5 cm		En-tête		4,4 cm

				D	4,5 cm		Pied de page	0 cm  	> Disposition : En-têtes 5 pages paires et impaires différentes 5 1° page différente

– Fichier > Format d’impression 		A4

– Outils   > Paragraphes > Enchaînement	5 éviter veuves et orphelines

– Outils   > Options > Impression	5 Réglage fin pour largeur		5 Dessins

		 > Composition automatique		5 Remplacer guillemets " par «  »

2.1.2. En-tête



La pagination et les titres courants de l’article seront insérés dans l’en-tête.

– Insère > Numéros de page > Position Haut de page > Format...> 1, 2, 3... à partir de 1

– Affichage  > En-tête > en-tête de page impaire	: insérer le titre courant de l’article et, séparée de 5 espaces, la pagination, l’ensemble en Times romain maigre, corps 9.

		> en-tête page paire : insérer le nom de la revue et, séparée de 5 espaces, la pagination, l’ensemble en Times romain maigre, corps 9.





2.2. Titres et sous-titres



2.2.1. Première page de l’article



– Le titre de l’article en français, et indiqué en annexe le titre en anglais (ou l’inverse selon la langue utilisée) doit être informatif et concis (de 3 à 8 mots significatifs). Dans le cas où il excèderait 40 caractères ou espaces, l'auteur en fournira une version abrégée (pour le « titre courant » à insérer par vos soins dans le premier en-tête des pages impaires).

Le titre est composé en corps 18 gras romain minuscule, interligné 12 points. Si le titre comporte deux lignes, insérer une ligne de blanc entre les deux lignes. S'il y a un sous-titre, il sera en corps 14 gras romain. Il sera précédé et suivi de deux lignes de blanc et bordé d’un trait supérieur fin. (Format > Bordure supérieure en trait fin)

– Le prénom et le nom des auteurs sont composés en corps 12 gras romain minuscule, interligné 12 points. 

– Les coordonnées des auteurs (appartenance, adresse professionnelle et adresse électronique, pas de téléphone ni de fax) sont composées en corps 10 italique maigre, interligné 12 points.  Elles seront précédées et suivies d’une ligne de blanc.

Un modèle de première page comportant plusieurs auteurs à des adresses différentes est donné en annexe I.

– Le résumé et les mots-clés sont donnés impérativement en français et en anglais, dans l’ordre suivant : résumé, puis abstract, puis mots-clés, puis key words si l’article est rédigé en français. Abstract, puis résumé, puis key words, puis mots-clés si l’article est rédigé en anglais.

Cet ensemble est composé en corps 9 italique maigre, minuscule, interligné �11 points  sauf les termes : RÉSUMÉ. ABSTRACT. MOTS-CLÉS : KEY WORDS: qui sont composés en petites capitales accentuées suivis, comme sur ce modèle, d’un point ou de deux points, et entre 2 filets (trait fin) en bordures supérieure et inférieure, distance au texte de 4 points.

– Sur la dernière ligne de cette première page apparaîtra la signature de l’article comprenant le nom de la revue, le numéro du volume et l’année de parution ainsi que le numéro des pages dans le volume. Celle-ci est composée en corps 9 romain maigre, minuscule, et sera mise à jour lors de la composition du numéro de la revue par le service fabrication.



2.2.2. Titre des paragraphes ou titre d’ « inter »



Ils sont tous alignés sur la marge gauche en numérotation décimale :

– le premier niveau est en Times corps 10 minuscule, chiffres et texte en romain gras (exemple : 2. Titre de  niveau 1),

– le deuxième niveau est en Times corps 10 minuscule, chiffres en romain gras, texte en italique gras (exemple : 2.1. Titre de niveau 2),

– le troisième niveau est en Times corps 10 minuscule, chiffres en romain maigre, texte en italique maigre (exemple : 2.1.1. Titre de niveau 3),

– le quatrième niveau est en Times corps 10 minuscule, chiffres et texte en romain maigre (exemple : 2.1.1.1. Titre de niveau 4).

Il faut prévoir deux lignes de blanc au-dessus de chaque titre d’inter de premier et deuxième niveaux, et une ligne de blanc en dessous ; une ligne de blanc au-dessus de chaque titre d’inter de troisième et quatrième niveaux, et une ligne de blanc en dessous.





2.3. Les alinéas



Ils sont d'un renfoncement (ou retrait de 1re ligne) de 5 mm.





2.4. Les notes de bas de page�



Elles sont en bas de page, en corps 8, interligné 11 points, justifié sans alinéa, numérotées de 1 à n à l'intérieur de l'article, séparées du texte proprement dit par un blanc d’une ligne et surmontées d'un filet maigre de 2,5 cm. L’appel de note dans le texte est également en corps 8.





2.5. Figures et tableaux



Les figures, illustrations et tableaux doivent être incorporés au texte. Les figures et illustrations sont numérotées de 1 à n à l'intérieur de l'article, les tableaux également. Des légendes explicites les accompagnent, composées en Times corps 10 justifiées, Figure x en romain gras suivi d’un point gras, texte en italique maigre :



Cadre et quadrillage en trait fin. Une ligne de blanc au-dessus, une ligne de blanc entre la figure ou le tableau et la légende. Deux lignes de blanc sous la légende.��

Figure  3. Consignes

2.6. Formules



Celles d'entre elles qui font l'objet d'un renvoi dans le texte sont numérotées de [1] à [n] entre crochets. Ce numéro, placé sur la première (ou la dernière) ligne de la formule, est aligné sur la marge de droite. Une ligne de blanc au-dessus et au-dessous de la formule sépare celle-ci du reste du texte. Si la formule doit être coupée (pour cause de longueur) mettre 1/2 ligne de blanc entre les lignes de l'expression.





2.7. Enumérations



Les auteurs utiliseront uniquement des tirets, de différentes tailles s’il existe plusieurs niveaux. Ne pas utiliser de puces ou de flèches. Exemple :

— Les auteurs utiliseront uniquement des tirets, de différentes tailles s’il existe plusieurs niveaux. Ne pas utiliser de puces ou de flèches. Exemple :

– Les auteurs utiliseront uniquement des tirets, de différentes tailles s’il existe plusieurs niveaux. Ne pas utiliser de puces ou de flèches. Exemple :

- Les auteurs utiliseront uniquement des tirets, de différentes tailles s’il existe plusieurs niveaux. Ne pas utiliser de puces ou de flèches.



Le texte doit toujours revenir en début de ligne et respecter la justification (largeur de la ligne) de 120 mm.





2.8. Remarque ou note



Les « remarque » ou « note » se composent en petites capitales maigres suivies d’un point, puis d’une espace, puis d’un tiret long : 

Note. — ...					Remarque. — ...





2.9. Typographie



Pour les textes rédigés en français :



Une seule espace après le .	Une espace après « et une espace avant »

Une espace avant : 		mais pas d’espace après “ni avant”

Une espace avant ;		Pas d'espace avant une virgule ou un point

Une espace avant ?		Pas d'espace intérieure pour (...) {...} [...] 

Une espace avant %		Points de suspension = ...  (trois points) sans 

Une espace avant et après = + -	espace avant		mais 	etc.



Pour les textes rédigés en anglais, la typographie est différente (pas d’espace avant les : ; ? % et guillemets “pour l’anglais” sans espace).

2.10. Remerciements



Le texte des remerciements vient se placer après la conclusion séparé de celle-ci par deux lignes de blanc, avant la bibliographie, sous la forme (ceci est un modèle, texte à votre convenance) :





Remerciements



Les auteurs tiennent à remercier le laboratoire pour son soutien financier et les lecteurs anonymes pour l’aide qu’ils leur ont apportée...





2.11. Bibliographie



Composées en corps 9 romain, interligné 11 points, les références sont rassemblées en fin d'article par ordre alphabétique, espacées les unes des autres de �6 points ; leur numéro, du type [kol 97], est placé entre crochets. Le nom de l’auteur est composé en petites capitales, avec un alinéa négatif de 5 mm (dans Menu, aller à : Format > Paragraphe > Retrait de 1re ligne Négatif de 0,5 cm).



Voici, en guise d'exemple, quelques cas de figures parmi les plus courants :

– pour les ouvrages (titre en italique, le reste en romain)

[KOL 97] Kolski  C., Interfaces homme-machine, Editions Hermès, Paris, 1997.

– pour les revues et actes de conférences publiés (titre de la revue ou de la conférence en italique, le reste en romain)

[DEM 94] Demeure I., Farhat J., « Systèmes de processus légers : concepts et exemples », Technique et Science Informatiques, vol. 13, n° 6, 1994, p. 765-795, Hermès, Paris.

[LAL 97]  Lallouet A., « DP-LOG : un langage logique data-parallèle », Actes des �6e journées francophones de programmation logique et programmation par contraintes JFPLC'97, Orléans, 26-28 mai 1997, Editions Hermès, Paris, p. 53-68.

– pour les rapports internes et les thèses (texte tout en romain) :

[BRA 95] Braun T., Diot C., Hoglander A., Roca V., « An experimental user level implementation of TCP », rapport de recherche n° 265, septembre 1995, INRIA.

[NAW 97] Nawrocki A., « Contribution à la modélisation des câbles monotorons par éléments finis », Thèse de doctorat, Université de Nantes, Ecole Centrale de Nantes, 1997.







2.12. Biographie



Pour les revues qui demandent une biographie, les auteurs indiqueront en quelques lignes placées en fin d’article, les événements essentiels de leur carrière en insistant sur leurs domaines d’intérêt techniques et scientifiques. Ce texte doit être composé en Times corps 9 italique, interligné 11 points, justifié sans alinéa, séparé de la dernière ligne de l’article par deux lignes de blanc, nom de l’auteur en caractères gras, texte en caractères maigres. Une ligne de blanc est à insérer entre chaque auteur. Exemple :





Béatrice Sorel est ingÈnieur... Elle est actuellement allocataire de recherche et prÈpare une thËse au sein du... Ses travaux portent sur l'utilisation de techniques formelles (algËbre des corps finis, mÈta-modÈlisation, logique temporelle) pour la vÈrification, la validation et la simulation du GRAFCET.



Yves Saulnier est professeur agrÈgÈ et docteur de... en automatique. Il est actuellement maÓtre de confÈrences habilitÈ et directeur du.... Ses activitÈs de recherche concernent les mÈthodes d'ingÈnierie intÈgrÈe des systËmes de production complexes et les langages de description des systËmes rÈactifs.





3. Remise des articles



Les articles adressés en soumission seront envoyés en 6 exemplaires au rédacteur en chef de la revue concernée, auprès des Editions Hermès. Tous les documents étant numérisés, nous remercions les auteurs de bien vouloir prendre contact, dès la saisie de leur article, avec le service informatique, afin de vérifier la compatibilité des fichiers et les sources utilisées.

Les articles, après acceptation définitive, seront adressés en document attaché à :

hermes@iway.fr

ou sur disquette (fichier source et version postscript) accompagnée d'une sortie papier laser, pour document témoin, et d'une copie des polices de caractères utilisées, dans le cas de symboles particuliers.

Les auteurs ayant utilisé Latex doivent fournir les fichiers sources (*.tex, *.sty,...) et la version postscript. Si un style french a été utilisé, celui-ci doit être fourni.

Les articles qui ne respecteront pas exactement ce format ne pourront pas être pris en considération. 

Nous prions les auteurs d'indiquer leurs numéros de téléphone, de télécopie et leur adresse électronique.

Nous restons à votre disposition pour toute information complémentaire.



Le Service Fabrication

hermes@iway.fr

Annexe I



Nous donnons un modèle de présention du haut de la première page dans le cas de plusieurs auteurs et de plusieurs appartenances. Les auteurs sont séparés par un tiret long (caractère spécial) maigre. L’appartenance est notée par une (ou plusieurs) étoile(s) qui sera placée en correspondance avant le texte de l’appartenance. Pour une adresse électronique commune à plusieurs auteurs, les noms des auteurs seront réunis entre deux accolades, séparés chacun par une virgule. 

Si l’article appartient à une rubrique, le nom de celle-ci sera inséré au-dessus du filet supérieur, composé en petites capitales, Times corps 14 maigre. Exemple :





recherche





Couplage endommagement-décalcification



du béton



Etude d'une modélisation numérique





Laurent Molez*,** — Bruno Gérard** — Gilles Pijaudier-Cabot*,***



*Laboratoire de Mécanique et Technologie, ENS de Cachan

CNRS/Université Pierre et Marie Curie 

61 avenue du Président Wilson, F-94235 Cachan cedex

{nom, nom}@laboratoire.fr

**Electricité de France, Direction des Etudes et Recherches 

Dépt. MTC, BP 1 , F-77818 Moret-sur-Loing cedex

*** Institut Universitaire de France





Annexe II

Liste des logiciels acceptés



- Word 6 sous Macintosh

- Word 6 et 7 (Word 95) et Word 97 sous PC

- Latex version 2e  : une feuille de style est disponible sur 

http://www.editions-hermes.fr



�  Note composée en corps 8, sans alinéa.



�



� PAGE �8�     Revue. Volume 1 – n° 1/1998



Titre courant de l’article     � PAGE �7�








